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Safety Precautions

The following are general safety precautions that are not necessarily related to 
any specific part or procedure, and do not necessarily appear elsewhere in this 
publication. These precautions must be thoroughly understood and apply to all 
phases of operation and maintenance.

WARNING
Keep Away From Live Circuits

Operating Personnel must at all times observe general safety precautions. Do 
not replace components or make adjustments to the inside of the test 

equipment with the high voltage supply turned on. To avoid casualties, always 
remove power.

WARNING
Shock Hazard

Do not attempt to remove the RF transmission line while RF power is present.

WARNING
Do Not Service Or Adjust Alone

Under no circumstances should any person reach into an enclosure for the 
purpose of service or adjustment of equipment except in the presence of 

someone who is capable of rendering aid.

WARNING
Safety Earth Ground

An uninterruptible earth safety ground must be supplied from the main 
power source to test instruments. Grounding one conductor of a two 

conductor power cable is not sufficient protection. Serious injury or death can 
occur if this grounding is not properly supplied.

WARNING
Resuscitation

Personnel working with or near high voltages should be familiar with modern 
methods of resuscitation.

WARNING
Remove Power

Observe general safety precautions. Do not open the instrument with the 
power on.
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Safety Symbols

Note: Calls attention to supplemental information.

Warning Statements

The following safety warnings appear in the text where there is danger to 
operating and maintenance personnel, and are repeated here for emphasis.

On page 4.

Caution Statements

The following safety warnings appear in the text where there is danger to 
operating and maintenance personnel, and are repeated here for emphasis.

WARNING
Warning notes call attention to a procedure, which if not correctly performed, 

could result in personal injury.

CAUTION
Caution notes call attention to a procedure, which if not correctly performed, 

could result in damage to the instrument.

The caution symbol appears on the equipment indicating 
there is important information in the instruction manual 
regarding that particular area.

WARNING
Never attempt to connect or disconnect RF equipment from the transmission 

line while RF power is being applied. 
Leaking RF energy is a potential health hazard.



Safety Precautions

iv

Safety Statements

USAGE

ANY USE OF THIS INSTRUMENT IN A MANNER NOT SPECIFIED BY 
THE MANUFACTURER MAY IMPAIR THE INSTRUMENT’S SAFETY 
PROTECTION.

USO

EL USO DE ESTE INSTRUMENTO DE MANERA NO ESPECIFICADA 
POR EL FABRICANTE, PUEDE ANULAR LA PROTECCIÓN DE 
SEGURIDAD DEL INSTRUMENTO.

BENUTZUNG

WIRD DAS GERÄT AUF ANDERE WEISE VERWENDET ALS VOM 
HERSTELLER BESCHRIEBEN, KANN DIE GERÄTESICHERHEIT 
BEEINTRÄCHTIGT WERDEN.

UTILISATION

TOUTE UTILISATION DE CET INSTRUMENT QUI N’EST PAS 
EXPLICITEMENT PRÉVUE PAR LE FABRICANT PEUT 
ENDOMMAGER LE DISPOSITIF DE PROTECTION DE 
L’INSTRUMENT.

IMPIEGO

QUALORA QUESTO STRUMENTO VENISSE UTILIZZATO IN MODO 
DIVERSO DA COME SPECIFICATO DAL PRODUTTORE LA 
PROZIONE DI SICUREZZA POTREBBE VENIRNE COMPROMESSA.
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About This Manual

This manual covers the operating and maintenance instructions for the 
following software:

Changes to this Manual

We have made every effort to ensure this manual is accurate at the time of 
publication. If you should discover any errors or if you have suggestions for 
improving this manual, please send your comments to our factory. This manual 
may be periodically updated, when inquiring about updates to this manual refer 
to the part number and revision level on the title page.

Chapter Layout

Introduction — Provides an introduction to the RF Power Meter software. 
This chapter also lists the sensors compatible with the RF Power Meter 
software.
Operation — This chapter includes procedures for RF connections to a Bird 
power sensor as well as making a data connection between the computer 
running the RF Power Meter and a Bird power sensor.
User Interface — Provides a description of the menus and options available in 
the RF Power Meter Software.
Measurements — Details the measurements possible with Bird power 
sensors as well as providing basic procedures for making measurements with 
each Bird power sensor.

RF Power Meter Software
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Chapter 1 Introduction

The RF Meter is a Windows® application for use with many of Bird’s Power 
Sensors to measure RF power in a variety of systems.

Figure 1  RF Meter

Measuring RF Power

To measure transmitter RF power, connect the power sensor to the windows PC 
with RF Meter App Installed. RF Power measurements verify and monitor the 
condition of a transmitter system. See "User Interface" on page 6 for details on 
how to use the Bird RF Power Meter Software.

Software Installation

The Bird RF Meter software for Windows® is available for download from the 
Bird website, www.birdrf.com.
The Bird RF Meter software is installed by clicking the executable contained in 
the .zip archive file you downloaded.
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Compatible Power Sensors

Wideband Power Sensors (WPS)

5012D, 5016D, 5017D, 5018D, 5019D
The Bird Wideband Power Sensor (WPS) is a Thruline sensor that can be used to 
diagnose RF component integrity.
These sensor’s connect via USB, see "USB Connection" on page 5.
See "Wideband RF Power Sensor (WPS) Measurements" on page 29.
7020
The Bird 7020 series sensors are Thruline sensors that can measure forward and 
reflected average power and VSWR.
These sensor’s connect via USB, see "USB Connection" on page 5.
See "7020 Sensor Measurements" on page 31.

Directional Power Sensors (DPS)

5014
The 5014 sensor utilizes elements to make power measurements. Each element 
has an arrow on it that represents the direction in which it measures power. The 
elements ignore power in the opposite direction with a directivity of at least 25 
dB. 
The DPS series can make power measurements using either 43 type or APM/
DPM elements, and the readings available vary, based on which elements are 
being used.
The frequencies the 5014 is capable of measuring is dependent on the elements 
used.
These sensor’s connect via USB, see "USB Connection" on page 5.
See "Directional Power Sensor (DPS) Measurements" on page 32.
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Statistical Power Sensors 

The Bird Statistical Power Sensor (7022) is a Thruline sensor that can measure 
Average, Real Time, Peak and Statistical power. The frequency range of the 7022 
is 350 MHz to 6 GHz.
These sensor’s connect via USB, see "USB Connection" on page 5.
See "Statistical Power Sensor Measurements" on page 34.
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Chapter 2 Operation

RF Line Connection

1. Connect output of the transmitter to the input of the power sensor.
2. Connect output of the power sensor to the systems antenna or a load.

Figure 2  RF Power Measurement Setup

For a description of RF Power Meter Software displays and menus, see "Sensor 
Displays and Menus" on page 8.

WARNING
Never attempt to connect or disconnect RF equipment from a 

transmission line while RF power is applied. Leaking RF energy is a 
potential health hazard.
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USB Connection

1. Connect USB cable to Bird Power Sensor. See Figure 2 on page 4.
2. Connect USB cable to the computer.

Note: The Bird RF Power Meter Software will save all sensor settings 
(by serial number). Sensor settings will automatically load when the 
sensor is connected. Settings are saved in a Session File. Session Files 
are saved in the Session List.

3. The Power Sensor model number and serial number will be displayed on 
the Bird RF Power Meter Software Main Screen. 

Figure 3  Main Screen

4. Double click the Power Sensor model number to connect to the Power 
Sensor.

Zeroing a Sensor

Note: Not all power sensors require a zero cal, only sensors with the 
zero cal option on the Sensor > Actions Menu require zero cal.

Over time, the sensor's “zero value” (reading with no applied RF power) can 
drift, making all readings inaccurate by this value. For example, if the zero value 
is 0.02W, measuring a 50 W signal will give a reading of 49.98 W, a 0.04% error. 
Measuring a 1 W signal will give a reading of 0.98 W, a 2% error. If the drift 
would be a significant error, zero the sensor. 

Note: RF power must be turned off before zeroing a power sensor.
1. Ensure the sensor has reached a stable operating temperature.
2. Click the Sensor Menu.
3. Hover over or click the Actions option.
4. Click Zero Cal.
5. Verify no RF is applied to the sensor. 
6. Click Yes if no RF is applied.

Note: Calibration may take up to 40 seconds. Do not interrupt the 
calibration. A “Performing Zero Calibration” message will be displayed 
during the calibration.

7. Click OK on the zero calibration complete message.
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Chapter 3 User Interface

The Windows RF Meter consists of Two Screens:

 The Main Screen, see "Bird RF Meter Main Screen" on page 7.

 The Sensor Display, see "Sensor Displays and Menus" on page 8.

Figure 4  User Interface Displays
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Bird RF Meter Main Screen

The parts of the Main Screen are shown in Figure 5.

Figure 5  RF Meter Main Screen Description

Menu Bar

The menu bar contains the Tools menu and the Help menu
Tools Menu — The tools menu provides access to the session list.

Session List — This is a list of all session files saved from 
connecting to Bird Power Sensors. Session files are 
automatically created and saved for each sensor (by serial 
number) connected to the Bird RF Meter App. For more 
information, see "Session Files" on page 22.

Help — About, displays version and copyright information.

Sensors

The Sensors displayed here are “connected” to the Bird RF Meter and sensor 
measurement data may be displayed by double clicking the sensors name.



RF Meter

8

Sensor Displays and Menus

Figure 6  Power Meter Display

Item

1 Readings Tab

Displays the numerical readings available/selected 
device readings. The information on the readings 
menu can also be displayed in table or graphical 
format in the measurement area. See "Readings 
Tab" on page 9.

2 Sensor Menu

Used to load Presets, select modes, send device 
commends, start Logging and share measurement 
results. See "Sensor Menu" on page 12 for detailed 
description of the available options. 

3 Graphs Menu /
Graph Menu

Graphs Menu is used to display a graphical display of 
the sensors measurements. See "Graphs Menu" on 
page 15.

4 Configuration 
Tab 

Used to configure the sensor, options available are 
sensor specific. See "Configuration Tab" on page 
10.

5 Measurement 
Display Area

Measurement data is displayed in this area and can 
be formatted in tabular or graphical format. See 
"Display Area" on page 14.
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Readings Tab

Displays the numerical readings for the connected device. 

Figure 7  Readings Tab

Changing Unit of measure
Note: The Bird RF Power Meter Software will save all settings for each 
sensor (by serial number). Sensor specific settings will automatically 
load when the sensor is connected. All settings are saved in Session 
Files.

The Unit of measure for any of the measurements may be changed.
1. Right click on the measurement to display the Edit Unit menu.

Figure 8  Edit Unit menu

2. Click Edit Unit.
3. Click the measurement unit and select the new unit of measure from the 

drop down list.

Arranging the Readings Tab Order
The order of the measurements in the readings tab maybe changed at any time 
using the mouse.
1. Click and drag any measurement to a new location within Readings Tab then 

release.
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Configuration Tab

The configuration tab provides sensor specific options for preparing the RF 
Meter Software to accurately display sensor measurements.

Figure 9  Configuration Menu

Note: Menu options and readings displayed will vary according to the 
capabilities of the connected sensor.

Input Offset — Offset menu is used to enter the total value of all couplers and 
attenuators connected to the sensor (for example, the coupling factor of a 
directional coupler).
Double click Input Offset, enter the total attenuation of couplers and 
attenuators connected to the sensor, then click Ok.
Smoothing — All models except Statistical Power Sensors:
Smoothing is a simple arithmetic mean calculated on the most recent (selected 
value) measurements. Smoothing is applied to the sensor data as it is received 
from the sensor. 
Double click Smoothing, select value from drop-down list, then click Ok.
Forward Scale — For model 5014 Sensors only:
Double click Forward Scale, enter the rating of the forward element, Select unit 
from drop-down list, then click Ok.
See "5014 Sensor Element Types" on page 33 for information about elements.
Filter Value — For Wideband Power Sensors (501X):
Set filter value, this filter can be set to either 4.5 kHz, 400 kHz, or full bandwidth, 
see "Video Filter" on page 30.
CCDF Limit — For Wideband Power Sensors (501X):
Enter the threshold to be used for CCDF measurement.

Note: Statistical Power Sensors (7022) have numerous unique 
configuration settings, for a description of these settings, see 
"Statistical Power Sensor Measurements" on page 34.

Correction Frequency — For Statistical Power Sensors Only:
Enter the frequency under test, or allow sensor to automatically detect 
frequency under test (default).
Correction Frequency Auto Enabled — For Statistical Power Sensors Only:
Enter the frequency under test, or allow sensor to automatically detect 
frequency under test (default).
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Duty Cycle — For Statistical Power Sensors Only:
Enter the Duty Cycle of the system under test, or allow sensor to automatically 
detect the Duty Cycle of the system under test (default).
Duty Cycle Auto Enabled — For Statistical Power Sensors Only:
Enter the Duty Cycle of the system under test, or allow sensor to automatically 
detect the Duty Cycle of the system under test (default).
Bandwidth — For Statistical Power Sensors Only:
Set bandwidth (filter value), this filter can be set to either 4.5 kHz, 500 kHz, 5 
MHz, or None (no filter, full bandwidth). See "Bandwidth (Video Filter)" on 
page 36.
Smoothing — For Statistical Power Sensors Only, Average Mode Only:
Smoothing is a simple arithmetic mean calculated on the most recent (selected 
value) measurements. Smoothing is applied to the sensor data as it is received 
from the sensor. 
Double click Smoothing, select value from drop-down list, then click Ok.
Run Mode — For Statistical Sensors, Statistical Measurement:
Select whether a single measurement is acquired, or measurements will 
automatically be repeated.
Confidence Percentage, Sample Time, and Sample Count — For 
Statistical Sensors, Statistical Measurement:
Select one of these settings to adjust, Confidence, Sample Time, or Sample 
Count. Setting one of these affects the other two settings, only one needs to be 
adjusted for each measurement, see "Confidence Percentage" on page 38.
Error Tolerance — ??????
Dynamic Range — For Statistical Sensors, Statistical Measurement:
Select the decibel measurement range for each measurement, this setting will 
determine the values on the x-axis of the graphed results.
Sample Interval — For Statistical Sensors, Time Domain Measurement:
Select the desired time interval between samples (this will affect the length of 
time required to complete Time Domain Measurement).
Trigger settings — For Statistical Sensors, Time Domain Measurement:
Select trigger source, trigger mode, trigger edge, trigger level, trigger hold off, or 
trigger delay. See "Time Domain Mode" on page 36.
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Sensor Menu

Figure 10  Sensor Menu

Share Readings — The Share Readings function will open a text report of the 
current measurement readings.
About Sensor — Displays the model number, serial number, and firmware 
version of the connected sensor.
Enable Updates — When checked, measurement readings and graphs will be 
updated with current sensor measurements. When unchecked, updates of 
measurement readings and graphs will be paused.
Start Logging — The Start Logging function will log measurements to a text 
file. See "Logging Options" on page 13.

Note: Logging is Mode specific, if the sensor in use has multiple modes 
and the mode is changed, logging will automatically stop.
Load Preset — This option allows you to load a preset configuration file, see 
"Session Files" on page 22 for details.
Modes — The options available in this menu are sensor dependent. when 
available, the modes available for the connected sensor are displayed as 
options.

Statistical Sensors — The modes available for Statistical 
sensors are Statistical Power, Time Domain Power, Average 
Power.

Actions — The options available in this menu are sensor dependent. 
The Actions menu contains actions available for the connected sensor such as 
Zero Calibration or Alarm Reset.

Zero Cal — Some sensors include a zero calibration feature. 
For these sensors, pressing Zero Calibration will cause the 
sensor to be calibrated to compensate for noise in the 
transmission line when no RF power is actually present. RF 
must be removed before performing calibration. The length 
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of time required for calibration will vary by sensor being 
used.
A "Performing Zero Calibration" message will be displayed 
during the calibration. A message will be displayed indicating 
a successful calibration or calibration failed. If the calibration 
fails, check the sensor connections and try again.
See "Zeroing a Sensor" on page 5.

Logging Options

Logging function will log measurements to a text file. The logs are saved in the 
User’s Documents folder: /Documents/Bird RF Meter/Logs.

Figure 11  Logging Options

1. On the Sensor Menu, click Start Logging 
The Logging Options Dialog Box will open, see Logging Interval and Logging 
Condition. The menu option will change to Stop Logging once logging is 
activated.

2. Logging will continue until Stop Logging is clicked, on the Sensor Menu.
Note: If Logging Interval and Logging Condition are both checked. 
 Logging will occur when the condition is met AND the interval has 
elapsed.

Logging Interval — Logging Interval is used to set a repetitive time used to log 
all sensor measurements.
Enter a repeat time and select from seconds, minutes, or hours.
Logging Condition — Logging Condition is used to set a criteria for logging. 
Select a measurement and the criteria the measurement must meet or exceed 
for logging to take place.

Viewing Logged Data
The logs are saved in the User’s Documents folder: /Documents/Bird RF Meter/
Logs. See "Logging" on page 19 for details about the log files. 
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Display Area

Reading Table — Sensor measurements are displayed in the reading table in a 
list format.

Figure 12  Reading Table

Graphical Displays — Any readings may be displayed in graphical or tabular 
format by clicking the Graphs Menu to display the graph options and selecting a 
graph from the list. See "Graph Displays" on page 15 for additional information. 

Figure 13  Graphical Displays
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Graphs Menu

Figure 14  Graphs Menu

Graph Displays
Any measurement can be displayed in graphical or tabular format. Several 
different graph types may be displayed.
Click the Graphs Menu to display the graph options.
Graph List — Default options are New Bar Graph, New Time Graph, and New 
Data Set Graph (CCDF and Time Domain modes only). Any saved graph for the 
current sensor/mode will also be displayed on the list. See "How to Display a 
Graph" on page 16.
Reading Table — The reading table displays all of the connected unit's 
measurements in a tabular format. The reading table will be displayed until a 
different option is selected.

Graph Types
Any power measurement on the readings menu may be displayed on a graph. 
See "How to Display a Graph" on page 16. Graph setup may also be saved so 
frequently used settings will automatically be selected.

Note: Graphs are saved for the mode only. If the mode is changed the 
saved graph will not be available, until the device/mode associated 
with the saved graph is reconnected. Graphs can be saved for other 
devices of the same type by saving a Default Preset.

Time Graph — The time graph displays signal measurements over time. The x-
axis displays the time of the reading, the y-axis displays the measurement value. 
The graph is limited to 2000 data collection points, once the graph reaches this 
limit the oldest data is discarded as new data is added, so the chart data will 
constantly be shifting to the left side of the screen. See "Graph Controls" on 
page 17 for detailed information on interacting with Time Graphs.
Bar Graph — The bar graph displays instantaneous power levels of one or 
more signal measurements. The x-axis displays the name of the reading, the y-
axis displays the measurement value. The graph initial setting is a single bar, but 
additional bars may be added. See "Graph Controls" on page 17 for detailed 
information on interacting with Bar Graphs.
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Data Graph — Power CCDF and Time Domain measurements are displayed on 
a Data Graph. The results are displayed following a measurement and continue 
to be displayed until a new scan is triggered. See "Graph Controls" on page 17 
for detailed information on viewing Data Graphs.

Note: Data Graphs are not available on all sensors.

How to Display a Graph

1. Click the Graphs Menu to display the graph options.
2. Click the name of graph type you wish to display (New Bar Graph, New Time 

Graph, New Data Set Graph).
A Create Graph Dialog box will be displayed.

Note: It is recommended a descriptive name be used as graph names, 
including graph type and other distinguishing information, since 
multiple graphs may be saved.

3. Click the name of the graph in the Create Graph Dialog and replace it with a 
descriptive name. See Figure 15.

Figure 15  Rename New Graph

4. Select the measurement to graph from the drop-down menu.
5. Click Ok.
6. The new graph will now be displayed in the Graphs Menu below Reading 

Table.
7. Click Graphs menu, select the graph's name in the menu to display the 

graph.
Note: Graphs are saved for the current mode only. If mode is changed 
the saved graph will not be available until the mode associated with the 
saved graph is selected. Graphs can be saved by saving a Default Preset.

Note: Only the settings are saved, not the data. To save data see 
"Logging" on page 19. 

How to delete saved graphs
1. Click the Graphs Menu to display the graph options.
2. Click the name of the graph you wish to delete.
3. Click the Graphs Menu again.
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4. Click Delete Graph.

Graph Controls
Note: Graph controls are located in the Graph Menu.

Graph Readings
The graph initially opens with only one measurement displayed, additional 
measurements may be displayed using this menu option.
1. Click the Graph Menu.
2. Click Graph Readings to display the dialog. 
3. Select as many of the listed measurements as desired.
4. Click Ok after a check mark is displayed for all measurements you wish to 

display together on the graph.

Graph Unit
The graph unit of measure may be changed manually by selecting a unit from 
the menu.

Note: Changing the graph unit will automatically change the scale 
value.

1. Click the Graph Menu.
2. Click Graph Unit to display the dialog. 
3. Select the desired unit of measure from the drop-down list.
4. Click Ok.

Graph Scale
The graph scale on the Y-axis may be changed by manually entering the 
minimum and maximum scale values.
1. Click the Graph Menu.
2. Click Graph Scale to display the dialog.
3. Click drop-down list. Select Custom.
4. Click in the first value entry field (maximum) and enter the maximum scale 

value.
5. Click in the second value entry field (minimum) and enter the minimum 

scale value.
6. Click the units drop-down list and select the appropriate value.
7. Click Ok.

Add Marker
Note: Markers are not available on Bar Graphs.

1. Click the Graph Menu.
2. Click Add Marker.
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When Add Marker is clicked, a marker is added at the center point of the graph 
All markers are added at the center point of the graph.  The value of the signal at 
the marker position may be displayed in a list.

Marker List
1. Click the Graph Menu.
2. Click Marker List.
When Marker List is clicked, marker list is displayed on the screen to the right or 
below the chart. The marker list is removed from the screen by clicking Marker 
List a second time.

Figure 16  Marker List

Deleting Markers
Right click the marker number in the marker list, then click the Delete pop-up.

Figure 17  Delete Marker
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Logging

Sensor data can be logged by the Bird RF Power Meter Software. Logging saves 
all the sensors active readings into a text file. Logging can be started on the 
Sensor Menu. Logs are saved using the following file naming convention:

Figure 18  Log File Name Example

Viewing Logged Data
The Log files are saved on the computer running the RF Meter Software, in the 
Documents folder.
Typical Path: Documents>Bird RF Meter>Logs. 
The data is saved in JSON format in the log file. The data is broken into two 
sections and is shown below.
The data may be viewed as text in any text editor, or imported into a 
spreadsheet program. See "Importing Logs into Excel" on page 20 for steps to 
import into Microsoft Excel.

Log File Definition
Section 1: Data Definition, often referred to as an Object. The data logged will
vary according to the sensor connected when the log file is created.

Section 1 includes:
 Model, serial number, date and time log was created

 Readings definition

 Mode definition, including settings

Section 2: Data Array. The values recording in the log file are defined by the 
readings definition in section 1. Each array of values is prefaced by the word 
"results". Each log file will contain multiple data arrays, even hundreds or 
thousand depending on the length of time logging was allowed to run.
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Section 1 Example:
Note: The format of the data has been altered in the example for 
simplification, the text runs together in log files.

Section 2 Example:
Note: The format of the data has been altered in the example for 
simplification, the text runs together in log files.

Importing Logs into Excel
This procedure will display each group of results on one row with each 
measurement and values grouped by columns.
1. Open an Excel spreadsheet.
2. Select Data Tab.
3. Click From Text/CSV on the menu. The Import Text File dialog box will open. 
4. Select All Files, in the drop down menu at the bottom of the dialog box. Log 

files have the file extension .log.
5. Navigate to the folder containing the log file to import. i.e. Documents/Bird 

RF Meter/Logs
Note: Newer versions of Excel work differently than described in the 
next steps, in the newer versions ensure the delimiter is set to Comma, 
then click Load.

6. Select the file and click Import. This will open the Text Import Wizard.
7. On step 1, Select Delimited radio button, then click Next.
8. On step 2, select Comma and Other (add { ) as the delimiters, then click 

Next.
9. On step 3, click finish.

Figure 19  Log File Open In Excel

Note: Columns have been removed in the example for simplicity.
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Tools Menu

Click Tools on the RF Meter Main screen to display the Tools menu.

Figure 20  Tools Menu

Network Scan — This menu option scans the network the computer is 
connected to for any Bird devices connected to the same network. 
Add Connection — The menu is used to manually connect to a Bird Device on 
the same network as the computer. 
Session List — This is a list of all session files saved from connecting to Bird 
Power Sensors. Session files are automatically created and saved for each sensor 
(by serial number) connected to the Bird RF Power Meter Software. For more 
information see "Session Files" on page 22.

Help Menu

About — Displays copyright information and software source credits.
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Session Files

Session List Definitions
Session files are used to initialize the Bird RF Power Meter Software when a Bird 
Power Sensor is connected. The following definitions describe the different 
session files.

Figure 21  Session List

When a power sensor is connected to the Bird RF Meter the first time the 
Generic Session File (Default Preset if created) is used to initialize the App then a 
Serial Number Specific Session File is automatically created.
1. Default Preset: A menu option is provided that allows you to save a 

preferred setup as a Default Preset setup for all sensors of the same sensor 
type. 

2. Preset: A Preset is similar to a Default Preset, the difference is the Preset 
must be manually loaded to be used.

3. Serial Number Specific Session File: When a power sensor is connected to 
the Bird RF Meter the first time the Generic Session File (or Default Preset if 
created) is used to initialize the App then a Serial Number Specific Session 
File is automatically created. Any changes made to the configuration for the 
power sensor will be saved in the Serial Number Specific Session File (the 
Default Preset is NOT updated unless the menu option is used).

4. Generic Session File: (Generic Session Files do not appear in the Session 
List) The first time a Bird Power Sensor is connected to the Bird RF Power 
Meter Software the generic session file for that sensor type is used to 
initialize the software. The software will use default settings for the power 
sensor type. 

Open the Session List
1. Click Tools on the RF Meter Main screen to display the Tools menu.
2. Click Session List on the Tools menu.
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Figure 22  Session List Options

Save a Custom Configuration as a Default Preset
Note: Your custom setup can be saved as a Default Preset session file. 
This allows the same custom setup to be viewed the first time you 
connect to the same type of Bird Power Sensor. 

1. Connect to a Bird Power Sensor.
2. Setup the User Interface to your preferred setup. The following are 

examples of custom setup items:
a. Save configurations for Graphs.
b. Organize the readings menu.
c. Configure the sensor.
d. Setup logging criteria.

3. Click the Tools menu.
4. Click Session List.
5. Right click the session file for the device setup up above.
6. Click Save As.
7. Select Default Preset then click Ok. 

Note: You must delete any previous session files so your Default Preset 
will be used as the default Session File. This allows the same custom 
setup to be viewed every time you connect to the same type of Bird 
Power Sensor. 

Edit Session File
Once a session file has been created, you can easily edit the session file even 
when not connected to the sensor.
1. Click the Tools menu.
2. Click Session List.
3. Right click the session file.
4. Click Edit Session.
5. Edit any settings just as if the sensor was connected, any changes will be 

automatically saved in the selected session file. 



RF Meter

24

Export Session File
When you connect to a Bird Power Sensor with the Bird RF Power Meter 
Software a Serial Number Specific Session File  is created. You can also save your 
settings as the default settings for your power sensor type in a Default Preset or 
Preset.  All of these file types can be exported from the Bird RF Power Meter 
Software for use on other computers.
1. Click the Tools menu.
2. Click Session List.
3. Right click the session file.
4. Click Export.
5. Select export location in the Save As dialog box.
6. Rename the file if desired then click Ok. 

Import Session File
If you wish to import one or more Session Files, you must first copy the files onto 
the computer.
1. Transfer the desired Session Files onto the computer.
1. Click the Tools menu.
2. Click Session List.
3. Click File menu in the Session List.
4. Click Import Session.
5. Navigate to the Session Files location.
6. Select the file(s) for import in the Dialog Box (if no files are visible, repeat 

step 1).
7. Click Open.

Load a Session File
1. Connect a sensor.
2. Double click the sensor name on the main Screen.
3. Click the Sensor Menu on the Sensor Display Screen.
4. Click Load Preset.
5. Select the preset from the drop-down list in the dialog box.
6. Click Ok.

Delete Session File
1. Click the Tools menu.
2. Click Session List.
3. Right click on the Session File you wish to delete.
4. Click Delete.
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Chapter 4 Measurements

This chapter describes the measurements available for compatible sensors. 
The Measurement Descriptions section contains in-depth descriptions of some 
the measurements possible using Bird power sensors.
Procedures for each compatible sensor can be found in the following sections:

 "Wideband RF Power Sensor (WPS) Measurements" on page 29.

 "7020 Sensor Measurements" on page 31.

 "Directional Power Sensor (DPS) Measurements" on page 32.

 "Statistical Power Sensor Measurements" on page 34.

Measurement Descriptions

This section provides in-depth descriptions of some the measurements possible 
using Bird power sensors.

 Average Power

 VSWR

 Peak Envelope Power

 Burst Average Power

 Statistical Power Measurement

Average Power

All Sensors
Average power is a measure of the equivalent “heating” power of a signal, as 
measured with a calorimeter. It measures the total RF power in the system, and 
does not depend on number of carriers or modulation scheme. The WPS is a 
broadband sensor that measures power across its entire frequency range. Its 
diodes operate in their ‘square law’ region so that the detector output is directly 
proportional to the average power, without any additional error correction.
Average power is the most important measurement of any transmission system 
since the average power is normally specified on the operating license. It is also 
valuable as a maintenance tool, showing overall system health, and for 
calibration.
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Figure 23  Average and Peak Envelope Power - Square Wave Signal

VSWR

All Sensors
VSWR measures the relation between forward and reflected average power. The 
Bird Wideband Power Sensor calculates the VSWR from the Forward and 
Reflected Average Power measurements. Rho and Return Loss are also the same 
measurement, but in different units:

Rho

VSWR

Return Loss (dB)

The health of the feedline and antenna systems can be monitored using VSWR 
measurement under full power operating conditions. High VSWR is an indicator 
of feed line damage, overtightened cable or feed line clamps, or antenna 
changes/damage due to weather conditions, icing, or structural damage to the 
tower.

Average Power

Peak Envelope Power

0 W

50 W

100 W

Rho   PR PF=

VSWR 1 +
1 –
------------=

ReturnLoss dB  10 PR PF log=



Measurements

27

Peak Envelope Power

5012, 5016, 5017, 5018, 5019
Peak power measurements detect amplitude changes as a signal modulates the 
carrier envelope. The WPS operates in an asynchronous cycle: 300 ms of 
waveform sampling followed by a 50 ms reset period. The peak power is then 
displayed and the cycle repeats. The display therefore updates about three 
times per second.
Transmitter overdrive can be detected with peak measurements. Common 
problems are overshoot at the beginning of burst packets, amplitude 
modulation, and excessive transients. These damage system components with 
excessive peak power and also cause data degradation, increasing the Bit Error 
Rate. For TDMA applications, Peak and Burst Power measurements are used to 
detect overshoot in single time slots. Other time slots must be turned off for this 
test.

Burst Average Power

5012, 5016, 5017, 5018, 5019

Figure 24  Burst Average Power

Burst width (BW) is the duration of a pulse. Period (P) is the time from the start 
of one pulse to the start of the next pulse. Duty cycle (D) is the percentage of 
time that the transmitter is on. To calculate the duty cycle simply divide the 
burst width by the period (D = BW / P). Low duty cycles mean that the burst 
width is much less than the period; a large amount of dead time surrounds each 
burst. For low duty cycles, the burst average power will be much larger than the 
average power.
After peak power is measured, a threshold of ½ the peak is set. The sampled 
power crosses that threshold at the beginning and end of each burst. The time 
between crossings is used to calculate the duty cycle. Burst Average Power is 
calculated by dividing the Average Power by the Duty Cycle.
Burst power measurements provide accurate, stable measurements in bursting 
applications such as TDMA and radar. Accurately measuring the output signal 
strength is essential for optimizing radar coverage patterns. Actual transmitted 
power in a single time slot can be deter-mined in TDMA. The other time slots 
must be off during this test.

Average Power

Burst Average Power

Peak Envelope Power

0 W

100 W

50 W

Burst Width

Period
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Statistical Power Measurement

7022
Provides statistical measurements to display the percentage of time that a 
particular waveform exists at a specific peak to average power ratio.
The horizontal axis represents the peak to average power ratio of the waveform 
being measured. The vertical axis on the display represents time in percent. 
Reading a specific point on the graph provides information as to the percentage 
of time that the signal being measured exhibits a specific peak to average power 
ratio characteristic.
 Movable cursors are available within the display. These cursors may be located 
at any point on the curve, in order to determine specific values of the waveform 
peak to average ratio, and corresponding time.
Interpreting Statistical Data
There are many factors that influence the performance of modern 
communications systems. Some examples:

 The presence of interfering signals within the operating bandwidth of 
the system.

 Transmission line discontinuities resulting in multiple reflections within 
the transmission system.

 Poor amplifier linearity caused by amplifier compression. This results in 
signal distortion and poor fidelity of transmitted waveforms.

 Antenna damage or degradation resulting in high transmission system 
reflections. 

 Issues with transmitter modulator performance resulting in high error 
vector magnitude (EVM).

Many of the above transmission system issues may be identified through the use 
of the statistical techniques mentioned above. For example, if a particular LTE 
radio system was known to be dropping calls at a higher rate than expected, a 
service technician will need to know whether the problem is with the radio 
itself, or with some element of the transmission system, or with the air 
interface. 
Measuring the statistics of the base station radio, while terminated with a high 
quality 50 ohm termination, and then again with the radio connected to the 
transmission and antenna system will provide clues as to where the issues may 
be.
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Wideband RF Power Sensor (WPS) Measurements

See "Wideband RF Power Sensor (WPS) Measurements" on page 29. 
The WPS are available with the frequency ranges shown below:
5012D: 350-4000 MHz
5016D: 350-4000 MHz
5017D: 25-1000 MHz
5018D: 150-4000 MHz
5019D: 25-1000 MHz

Figure 25  Wideband Power Sensor

The 501xD can be used to measure:

 Forward Power
 Reflected Power
 Peak Power
 Burst Power
 Match Measurements
 Crest Factor
 CCDF (displayed when CCDF is selected for Mode)
 Duty Cycle (displayed when Avg is selected for Mode)

Measurement procedure

1. Connect the 501xD sensor to the computer using a USB cable. See "USB 
Connection" on page 5.

2. Zero the WPS. See "Zeroing a Sensor" on page 5.
3. Click Configuration tab.
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4. Enter the Input Offset value (total attenuation of couplers and attenuators 
connected to the WPS, if used).

5. Enter Smoothing value, if desired.
6. Enter Filter Value. See "Video Filter" on page 30 for an explanation of the 

filter.
7. Click Readings tab.

Video Filter 

Figure 26  Video Filter Settings, 300 kHz Signal

Except for average power and VSWR measurements, all WPS measurements rely 
on a variable video filter to improve accuracy. This filter can be set to either 4.5 
kHz, 400 kHz, or full bandwidth (10000kHz). It should be as narrow as possible 
while still being larger than the demodulated signal bandwidth (video 
bandwidth). Narrowing the filter limits the noise contribution caused by 
interfering signals. Listed below are some common modulation schemes and the 
appropriate video filter.

Video Filter  Modulation Type
4.5 kHz  CW Burst (Burst width > 150 μs), Voice Band 

AM, FM, Phase Modulation, Tetra
400 kHz CW Burst (b.w. > 3 μs), GSM, 50 kHz AM, DQPSK

Full Bandwidth 10000kHz  CW Burst (b.w. > 200 ns), CDMA, WCDMA, 
DQPSK, DAB/DVB-T

Filter
Too Small

Filter
Too Wide

Correct
Filter

Noise

Signal
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7020 Sensor Measurements

The 7020 is available in models covering the following frequency ranges:
350-4000 MHz
350-4200 MHz
25-1000 MHz

Figure 27  7020 Power Sensor

The 7020 sensors can be used to measure:

 Forward Power
 Reflected Power
 VSWR

Measurement procedure

1. Connect the 7020 sensor to the computer using a USB cable. See "USB 
Connection" on page 5.

2. Zero the sensor. See "Zeroing a Sensor" on page 5.
3. Click Configuration tab.
4. Enter the Input Offset value (total attenuation of couplers and attenuators 

connected to the WPS).
5. Click Readings tab.
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Directional Power Sensor (DPS) Measurements

Figure 28  Directional Power Sensor

The 5014 can be used to measure:

 Forward Power
 Reflected Power
 Match Measurements
 Sensor Temperature

Measurement procedure

1. Connect the 5014 sensor to the computer using a USB cable. See "USB 
Connection" on page 5.

2. Click the Sensor Menu.
3. Click Modes.
4. Select measurement type based on elements inserted in the sensor. See 

"5014 Sensor Element Types" on page 33.
5. Click Configuration tab.
6. Enter the Input Offset value (total attenuation of couplers and attenuators 

connected to the DPS).
7. Enter Forward Scale (watt rating of the forward element).
8. Click Readings tab.
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5014 Sensor Element Types

The DPS series sensors utilize elements in order to make power measurements. 
Each element has an arrow on it that represents the direction in which it 
measures power. The elements ignore power in the opposite direction with a 
directivity of at least 25 dB. The DPS series can make power measurements using 
either 43 type or APM/DPM elements, and the readings available vary, based on 
which elements are being used.
Since the DPS uses two elements, it can measure the quality of the system by 
comparing the forward and the reflected power. This is usually presented in the 
form of VSWR or Return Loss.
43 Type Elements
The 43 type elements are normally used to measure peak power. These 
elements can measure the peak power of a system with an accuracy of +/-8% of 
full scale as long as the signal meets the following requirements:
"At least 15 pps (pulses per second)
"Minimum pulse width of 15 us (800 ns if frequency is greater than 100 MHz)
"Minimum Duty Cycle of 0.01%
In addition, 43 type elements can be used to measure average power in signals 
with a peak-to-average ratio close to 1, like a CW or FM signals. In these cases, 
the average power is measured with an accuracy of +/- 5% of full scale.
APM/DPM Elements
The APM/DPM elements are used to measure true average power. True average 
power means the sensor provides equivalent heating power of the signal, 
regardless of modulation or number of carriers. These elements can measure 
average power with an accuracy of +/-5% of reading from full scale down to 
2.5% of full scale.
 Note: The equivalent heating power is dependent on the duty cycle of a signal. 
If a system puts out 50 watts with a 50% duty cycle, the APM/DPM elements will 
measure 25 watts.
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Statistical Power Sensor Measurements

Figure 29  Statistical Power Sensor

The 7022 has three measurement modes and can be used to measure:

 Average Power Mode
 Forward Power
 Reflected Power
 Match Measurements
 Frequency
 Sensor Temperature

 Time Domain Power Mode
 Peak envelope power
 Burst Average Power
 Power Time Series
 Duty Cycle
 Overshoot
 Width
 Rise Time
 Fall Time
 Off Time
 Period 
 Rep Rate

 Statistical Power Mode
 Confidence
 Duration
 Power CCDF
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Measurement procedure

If additional information about any settings is desired prior to beginning a 
measurement, see "Additional Information" on page 36. 
1. Connect the 7022 sensor to the computer using a USB cable. See "USB 

Connection" on page 5.
2. Select Sensor Mode on the Sensor Menu. 

 Average Power
 Time Domain
 Statistical Power

Average Power Measurement
1. Zero the STAT Sensor. See "Zeroing a Sensor" on page 5.
2. Click Configuration tab.
3. Enter Bandwidth value, if desired (see "Bandwidth (Video Filter)" on page 

36).
4. Click Readings tab.
Time Domain Measurement
1. Zero the STAT Sensor. See "Zeroing a Sensor" on page 5.
2. Click Configuration tab.
3. Select Bandwidth value, if desired (see "Bandwidth (Video Filter)" on page 

38).
4. Enter Sample Interval.
5. Select Trigger source and associated values, if desired. 
6. Click Readings tab.
7. Click the Sensor Menu.
8. Click Actions.
9. Click Start to initiate measurement.
Statistical Power Measurement
10. Click Configuration tab.
11. Select Bandwidth value, if desired (see "Bandwidth (Video Filter)" on page 

38).
12. Select normal Run Mode (single sweep) or Clear/Restart (continuous 

sweeps).
13. Select Confidence Percentage, Sample Count, OR Sample Time. Change only 

one of these parameters. See "Confidence Percentage, Sample Time, and 
Sample Count" on page 11.

14. Enter the dynamic Range value. This sets the dB scale (x-axis) for the graph.
15. Click Readings tab.
16. Click the Sensor Menu.
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17. Click Actions.
18. Click Start to initiate measurement.

Additional Information

Time Domain Mode
In Time Domain, the amplitude of a single frequency is measured, rather than 
sweeping a range of frequencies. The RF Meter measures and displays the 
amplitude of the frequency for a specified period (sweep time) and refreshes 
the display during the next sweep. The Time Domain trace resembles the 
horizontal line display on an oscilloscope.

Bandwidth (Video Filter) — The variable video filter is used to improve 
accuracy. The filter should be as narrow as possible while still being larger than 
the demodulated signal bandwidth (video bandwidth). Narrowing the filter 
limits the noise contribution caused by interfering signals. 

 None (no filter)
 4.5 kHz
 500 kHz
 5 MHz

Correction Frequency — Allows the user to input frequency to be measured 
or allow the sensor to determine frequency. This value will be used to apply a 
correction factor from the sensors look-up table.

 Setting is a user selectable value between 6 GHz and 3.5 GHz. The 
specified frequency will be used in correcting the power measurement.

 auto enabled (default, sensor determines frequency)

Note: Use correction frequency when the sensor is unable to measure 
the frequency of a signal.

Duty Cycle — Sets the duty of a measurement for determining the Burst 
Average power. If sensor is capable, the duty cycle will be inferred by the sensor 
hardware and reported. A user-defined duty cycle can be entered to override 
the sensor provided value and is used in subsequent calculations.
User settings for duty cycle: user selects duty cycle or allows the sensor to 
determine duty cycle.

 Setting is a user selectable value between 100.00 and 0.00
 auto enabled

Sample Interval — Desired time interval between samples.  Changing this 
setting will change the time duration of the Time Domain Measurement Graph. 
Actual time interval is the largest multiple of 1/44 Msps (~22 nanoseconds) less 
than the desired time interval. This setting will affect length of time required to 
complete Time Domain Measurement and the value on the x-axis of the graph.
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 Setting is a user selectable value between 0.001489 and 0.000001

Trigger Source — 
 Internal
 External
 Manual

Trigger Mode — 
 Single
 Auto
 Normal

Trigger Edge — 
 Rising
 Falling

Trigger Level — Specifies the power level required initiate a trigger. 

 user selectable value between 0 and 1500 watts.

Trigger Level Auto Enabled — Default is Disabled, the sensor uses the 
value specified in Trigger Level above. 
When set to Enabled, the trigger level is set automatically half way between the 
max and min values of the previous time domain data set.

Trigger Hold Off time — Specifies the minimum amount of time after one 
trigger before another trigger can occur.

 user selectable value between 0 and 1 second.

Trigger Delay — Time interval between the occurrence of the trigger and 
acquisition of data. 

 user selectable value between negative 3600 and positive 3600.

Statistical Power Mode
In Statistical Power Mode, the Bird RF Meter is capable of making meaningful 
power measurements of signals incorporating complex modulation methods. In 
essence, provide meaningful measurements independent of the modulation 
method used in the system.

Correction Frequency — Setting is a user selectable value between 6 GHz 
and 3.5 GHz.  Sensor uses this value to apply a correction factor from an internal 
look-up table.

Correction Frequency Auto Enabled — Default is Enabled, Sensor 
automatically determines the signal frequency and applies a frequency-based 
correction factor. 
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Duty Cycle — Setting is a user selectable value between 100 and 0.

Duty Cycle Auto Enabled — Default is Enabled, sensor automatically 
calculates the signals duty cycle.

Bandwidth (Video Filter) — See "Bandwidth (Video Filter)" on page 36 
under Time Domain Measurement.

Run Mode — 
 Normal, RF Meter takes one measurement and stops.
 Clear/Restart, Once one measurement is completed and displayed 

another measurement is started automatically.

Confidence Percentage — Setting is a user selectable value of: 80, 90, 95, 
99, 99.9, or 99.99%.

Sample Time — Setting is a user selectable value of  0.0261 (26.1 ms) to 
6.5535 seconds.

Sample Count — Setting is a user selectable value of 1144900 to 288354000 
samples.

Dynamic Range — Selects the x-axis chart scale, setting is a user selectable 
value 0 - 43 dB.

Confidence Percentage Sample Time (seconds) Sample Count
80% 0.0261 1148400
90% 0.0339 1491600
95% 0.0421 1852400
99% 0.0604 2657600
99.9% 0.6038 26571600
99.99% 6.03850 265694000
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